
gadchick
issue 2 : shoot, click and see



Table of Contents
Choosing A Lens

Gadchick Gets Crafty : Camera DIY

It’s Not You, Its Your Webcam

Editorial Bytes

Instantly Yours - A Short History of Polaroid

What’s in an Adventurer Photographer’s Bag

Gadchick Interviews - Laura Lawson

Going Digital - My Love Affair With The Pixel

Embracing Your Self Portrait

How To Photograph A Kid

How To Photoshop Your Ex Out of Photos
& Other Tips

Gadchick Reads : She’s Such A Geek

Excerpt from the Android Photographer

Why A Woman Photographs



Laura Lawson
Laura Lawson is a 20-something artist, writer, and wannabe photographer currently 
based in the San Francisco Bay Area. She has been an avid iPhoneographer 
since 2011. Laura is an advocate for the low vision/blind community since 
getting diagnosed with retinitis pigmentosa in 2010. To learn more about Laura’s 
creative efforts or to just say hi, visit her at www.lauralawsonart.com.

Diana LA Counte
Diana is a consultant director for various publishing companies. 
When she’s not being a syntax ninja, she is a creative freelance 
writer. She helps her husband- a writer, professor and librarian 
tend to their 2 dogs and 3 cats. Founder of Gadchick, she’s 
been known to buy shiny new gadgets over shiny new shoes. 
She hopes to invent something one day that will make Oprah’s 
Favorite Things List. She blogs at ourcitylights.org.

Aline Callicott
Aline is a social media obsessed technology lover and video game 
enthusiast. When she is not Tweeting, G+ing, Tumbling, Pinning, or 
Facebook stalking for Gadchick, she is hard at work on her fashion and 
lifestyle blog. Always a camera and Android phone by her side, much of 
Aline’s free time is spent gaming with her boyfriend. She can be found 
CTRL+TABing between high heels on sale, Reddit comments, Hello 
Kitty, Steam sales, tech forums, a Newegg login screen, an Etsy logout 
screen, and the meme you’re going to stumble upon later this week.

Erin Micheletti
When Erin Micheletti isn’t playing with Photoshop, this New Media Director turned 
freelance writer is busy adding stamps to her passport, scuba diving, perfecting 
her secret cheesecake recipe, and writing about technology and travel.

Mandy Curtis
Mandy Curtis, purveyor of nerdery, blogs on Chocolate and Cream Cake. 
When not geeking out about everything Doctor Who, lusting after everything 
neon yellow (it’s the new neutral!), hyperventilating over the latest Mass 
Effect 3 trailer or planning her next (500) projects with the help of Pinterest, 
she has an alter ego as a copy editor and writer. Mandy lives in Austin with 
her husband and their animals: Mal, the “long-haired domestic” cat, and 
Mrs. Mollie Weasley, the chihuahua-mutt.

Chantilly McKinnon
Chantilly McKinnon is a kitsch loving, junk food eating, blog designing, thrift 
shopping, caking baking, craft making high class broad.  She lives in Ontario, 
Canada with her partner Jesse and daughter Georgia Grace.  You can find 
her blogging regularly at My Girl Thursday.
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Kinsey Mhire
Kinsey Mhire is a wedding and portrait photographer based in 
Springfield Missouri and the voice behind the blog Sincerely, Kinsey. 
She works for Elsie Larson where she is a DIY contributor for Elsie’s 
blog, A Beautiful Mess and helps run her local shop, Red Velvet Art.

Nan Lawson
Nan Lawson is a self taught Illustrator living and working in the Silverlake 
neighborhood of Los Angeles. There, she lives with her Boyfriend and two 
chubby cats while she daydreams about the perfect pair of glasses and her 
next cup of coffee. She draws quirky and nerdy things and characters, which 
are often inspired by hipsters, cult television shows, and flea markets. She 
sells prints of her work through her shop at nanlawson.etsy.com and has an 

illustration blog at outfitink.tumblr.com.
Chelsea brown
Chelsea Brown is a 23-year-old freelance journalist living in Phoenix, Arizona. 
She has her Bachelor’s degree in Journalism, and is working toward her 
Master’s in Communication Studies. She pens a personal style and lifestyle 
blog called Tea Talk, where she writes about her daily outfits, life with her 
sweet boyfriend and their adventures in the Phoenix Metropolitan Area. She 
adores iced coffee, personal style, and blogging.

Beca Lewis Skeels
Beca Lewis Skeels is a filmmaker, unconventionally trained pastry chef 
and co-owner of the Tumbleweeds Eyewear Company, this Southern girl 
still makes the time to shoot photos, blog and read too many books.

Rhianne Moore
Rhianne Moore is a designer, photographer and blogger from the UK with 
a passion for photography, modern design and other distractions. Originally 
from Norwich, Rhianne completed and Design degree in the North of England, 
where she now lives, focusing on computer aided, graphic and interior design. 
After graduation, Rhianne started a blog, For the easily distracted… which 
reignited her passion for photography and started an unexpected journey into 
blogging and writing, resulting in writing articles for Lomography and becoming 
a part of the Gadchick team.

Meg Fee
Meg Fee is a a born and bred Texan, who came of age on Manhattan’s west side, 
Meg is a Juilliard trained actor, who loves both writing words and bringing them 
to life. She is an actor, an essayist, a sometimes Vegan, and a fledgling baker. 
She loves toting her swanky Cannon all over the big apple, and looks forward to 
one day taking it off of auto. Until then. She blogs at the wild and wily ways of a 
brunette bombshell.

Ashlee Gadd
Ashlee Gadd is an aspiring writer, amateur photographer, and frozen yogurt 
addict. A self-proclaimed list-maker, joy-chooser, and devout yogi, she’s also 
currently rocking a baby bump and eating everything in sight. Ashlee is the 
Managing Editor of The Violet and blogs at Where My Heart Resides.
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Crisp, and clean, in focus and free of 
any direct blemishes. That is what most 
people are hoping for when they pull 
their camera up to their eye, look into the 
viewfinder, and snap away. However, this 
is not always the case. Some say they’re 
not photogenic, and others say they are 
just poor photographers, but in reality, they 
may just not be using the right lens for the 
occasion. 

How does one go about picking out the 
right lens? This can be an intimidating, 
and overwhelming process for many. For 
Canon and Nikon alone, there are dozens 
of lenses to choose from. When you go 
online, you can drown in a sea of lenses. 
Imagine, walking into a local camera store, 
surrounded by fancy (and expensive) 
camera equipment and not knowing where 
to start. However, it’s nice to go into lens 
shopping with some beefed up knowledge 
of what you’re looking for. 

You will end up walking away with a lens 
that will work best for you and what you are 
intending to photograph. With an array of 
lens types, it really can be a bit confusing. 

Portrait, telephoto, macro, wide angle, they 
are all great lenses, but what makes them 
the perfect lens for you? Well, it really all 
depends on what your focus is. Do you 
want to take more portrait style, or needing 
a wider angle lens to cover more ground 
in your photos? Are you looking to take 
great quality photos of tiny, or very close-
up objects, or do you just want a fun lens 
to play around with? Well, look no further, 
here at Gadchick we have put together a 
list of the most commonly used lens types, 
and are offering up details and advice on 
each of them. Being that we’re a woman’s 
focused magazine, we really want to look 
out for one another, and we thought it 
would be great to offer up some advice so 
that you don’t feel alone when you’re in 
search for a great new lens.

Choosing a Lens
by Chelsea Brown

Kit lenses

When purchased, most DSLR cameras come with kit lenses that 
are usually all held to the same standards. Most commonly they are 
an 18-55 mm, and have a zoom feature. These lenses are great if 
you’re just interested in capturing the moment, and not wanting to 
switch back and forth between lenses. Although they don’t offer the 
best quality photos, they are great for the price and versatility. 

Price point: $150 and up.



Macro lenses

These lenses are great for amazing close up shots. If 
you’re looking to photograph anything from nature, to 
jewelry, this is the lens for you. The most common of the 
macro lenses is a 50 mm, and they go up to about a 
125mm.Although these lenses are not the most practical 
for every day photography use, they are wonderful for 
bringing out the details on a small object. They focus 
directly on one subject and bring out the depth of field.  

Price point: $150 and up.
Telephoto lenses

Telephoto lenses are any kind of lenses 
that allow you to take close-up photos from 
far way. The most common telephoto lens 
is a 70-200mm, and is perfect for taking 
a great photo when you don’t want to be 
too intrusive of the space surrounded 
your subject. 

Price point: $150 and up.

Portrait lenses

A portrait lens allows you to take a crisp photo 
with little, to no distortion. They typically don’t 
have a zoom quality to them, and are dedicated 
to one focal length. The most common of the 
portrait lenses is the 50mm, and is great for 
taking headshots, outfit photos, and every day 
lifestyle photos. 

Price point: $100 and up.

Wide-angle lenses

Wide-angle lenses are simply fun. The wide-angle 
frame slightly distorts the look of your photo, but in 
a neat way. These lenses are often used for action 
shots, and more landscape/scenery type photos. The 
most common among wide-angle lenses is the 17mm, 
or the 16-35mm. If you’re looking for a unique view of 
a wide area, or wanting to get that perfect action shot, 
I’m sure a wide angle lens would work great for you. 

Price point: $400 and up.



Prime lenses

These lenses are great for when you’re looking to capture 
a very crisp photo. Prime lenses have a set focal length, 
and are among the higher quality lenses. The most 
common among prime lenses is the 50mm. From personal 
experience, I can highly suggest prime lenses as being a 
must-have in your camera bag. I’m constantly using my 
50mm, and love the sharpness it brings to my photos. I use 
this lens almost daily with outfit photos, and every day use. 

Price point: $150 and up.

Toy / Novelty lenses

Although quality lenses are a must in your camera 
bag, sometimes it’s fun to pull out a toy lens and 
take some really fun, artistic photos. Right now in 
the market there are a few great toy lenses that 
really stand out. The Dreamy Diana lens allows 
your DSLR camera to take photos just like you 
would if you were using the classic, toy plastic 
camera itself. The best thing about this is that 
you get instant gratification from being able to 
see your photos right after you take them (no 
film processing necessary). Holga also makes a 
similar toy DSLR lens that lets you capture the 
quality of Holga photos without having to use the 
actual toy camera itself. 

Price point: $30 and up.

Sarah Rhodes of Arrow and Apple Photography suggested doing a search on Flickr for the 
lens type you’re interested in using, and checking out all of the photos that were taking with 
that type of lens. This offers a unique way of testing out camera lenses before you even step 
into a camera store. Another great tip from Rhodes is she mentioned that each lens is going 
to act differently depending on what kind of camera body you are using. From this, I would 
suggest bringing your camera body along on your shopping trip so you can test out the lens 
on the actual camera you will be using it with.
 
Ok, so you’re now ready to take on your local camera store or favorite Nikon or Canon 
website with confidence and grace. If you get there and feel stuck, bookmark this issue 
of Gadchick and feel free to come back to us as a reference. Don’t be afraid to ask the 
store clerk questions and professional opinions. Most of them are hired because of our their 
knowledge of photography, and are usually always willing to extend a helping hand for an 
interested customer. Good luck, ladies!

Image Credits : Canon.com, Nikon.com and Lomography.com

http://www.arrowandapple.com/
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Time to close all the apps, put down the shiny handhelds, and dust 
off those craft supplies hiding behind all the wires and gizmos in the 
closet. Gadchick is getting crafty with Kinsey Mhire, DIY enthusiast. 
The project fits perfectly with this issue’s theme and it’s easy enough 
to do if you haven’t seen that craft box since bringing home macaroni 
frames from school.

Gadchick Gets Craf ty
Camera DIY



Supplies: Camera of your choice, (I chose 
an Instax Mini!), cotton fabric, scissors, 
exacto knife, Mod Podge, paint brush.1 First, cut out two squares of fabric about 

4 inches wider than your camera. 2

Once you’ve cut out the squares, apply 
mod podge in small sections at a time 
and press on the fabric. Make sure you 
don’t get Mod Podge on the buttons and 
flash! 

3 Once it’s completely covered, take the 
Exacto knife and carefully cut around the 
sections of unwanted fabric.4

Ta da! You’re finished! Enjoy your newly renovated camera. 

If you’ve done this project, we’d love to see it. Please email submission@gadchick.com and we’d love to 
feature your “new” camera, handheld, or even console on the Gadchick blog.

http://www.fujifilm.com/products/instant_photo/cameras/instax_mini_7/
mailto:submission%40gadchick.com?subject=Camera%20DIY


You don’t have to be intimidated or dressed to the nines (heck you don’t 
even really need pants) in order to use a webcam with family in distant 
places, telecommuting business meetings, obsessive Face Time-ers or your 
significant other. Whatever your purpose, webcams make us feel closer and 
more connected than your typical phone call, as long as you have updated 
webcam drivers installed, a stable internet connection, and follow these 
simple tips.

Light is your friend!
Keep some light on your face, say, a desk lamp, positioned equal to or above 
the height of your head. It’s nice when you face the brightest thing in the room 
(which could be hard when ceiling light typically faces one wall). On the contrary, 
a splash of bright light could be unflattering, so it couldn’t hurt to turn down the 
brightness on your monitor (especially if you wear glasses!); a completely dark 
background is rather creepy (see: 93% of Youtube webcam videos). And finally, 
like photography, nothing beats natural light. If you’re feeling daring, go outside! 
You have wi-fi don’t you? Sunlight, a blue sky, and a little breeze could make for 
a lively session.

It’s not you,
It’s your webcam

by Aline Callicott

Too Dark



Is This Thing On?
Although headset mics are arguably the most clear for communication, you can’t 
go through all this trouble to look and sound good only to sport cumbersome 
airplane pilot gear. After making sure input levels are optimum within the program’s 
settings (and troubleshooting), make sure your environment works with you. 
Background music is unnecessary, speak directly forward at a safe distance, 
and if you’re using a stand-alone mic, don’t hold it or fiddle with it. Even mics 
within laptops are sensitive to nudges and keystroke sounds. In fact, computer 
microphones in general can be sensitive to any minute sound. 
Pro-tip: mute button is your friend. It doesn’t require a lot of finesse to click 
without the person knowing, that way no one would know if your Diet Coke has 
you a little burpy on camera.

Location, location, location
It may feel a tad awkward, but you look better when you are looking at the camera 
at the top than when looking at the other person or yourself below. One tip is, 
move the video windows of yourself and/or the caller to the top of the screen, 
you can keep your eye on yourself/caller while it appears you’re looking right at 
the camera. The position and location of your camera and your face determine 
how natural the communication can feel. If on a laptop, make sure the camera 
isn’t below your eyes looking up. Try not to use your webcam while lying on a 
bed looking down.

Find a Blank (Or Clean!) canvas!
Nothing is more off-putting than having a video conversation with someone in 
a messy room. While having a laptop is the easiest way to find a good chatting 
spot, some may be confined to a desktop computer. If your setup is the latter, 
make sure to give your background a good cleaning. (I’m sure you did just take 
it out of the dryer, but the underwear on your bed needs to be folded and put 
away!) Remember, unless you’re session is in real clean HD the things behind 
you are probably showing up dark and grainy.

https://support.skype.com/en-us/category/CALL_QUALITY/
http://www.techradar.com/news/internet/skype-for-windows-update-brings-full-hd-calling-1060663


Your Pretty Pretty Face
A touch of blush goes a long way! The harsh light and poor quality of webcams 
can really wash you out. Even if I have an otherwise bare face, I try to make 
sure that I have a bit of color on my cheeks to give me some warmth. Go with a 
“natural” look, you will come off as trying too hard if you are in full makeup while 
sitting in your room. A little bit of powder to keep the shine down, a light gloss, 
and a swipe of mascara should do. Whether you wear white or have a white 
background, most webcams automatically white balance. Feel free to fiddle with 
the video settings in the program; you won’t break your computer by adjusting 
hue and quality settings. If your background, face, and colors are reading well, 
slightly turning up the saturation could really liven up your image. G+, Skype and 
Facetime all give you a visual preview of what you look like before you initialize 
the session, but it’s good to have a test site to check both visuals with sound. We 
like TestCamera, and Trust’s web cam tester. Use these to find your best angles 
and to make any last minute fixes to your hair and makeup.

Very few people go through the trouble of properly setting up their webcam 
for optimum results. Typically we use our webcam with people that we are 
most comfortable with and don’t have to be red-carpet-ready. If you want 
to feel like a million bucks you can, in your pajama bottoms and Hello Kitty 
slippers. No one will be the wiser! 

Bad Good

http://mailvu.com/testCamera/TestYourWebCam.html
http://www.trust.com/service/guides/webcam/
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“Editorial Bytes” by Diana La Counte

When I was a girl, I had my picture 
taken with Santa; 10 seconds later, 
an elf handed a watery grey paper 
to my mom, and before my eyes that 
image transformed into a photo. It was 
amazing! And love at first sight!
 
Flash-forward twenty-five some odd 
years, and welcome to generation 
NOW! Everything is instant—the 
Internet is in our pocket…literally. Even 
now, there’s still a bit of magic left in 
Polaroid, and if you don’t believe me, 
then hear me out as I tell you a story 
about Goofy. Yes, that Goofy.
 
Not long ago, I had an expiring pack 
of Polaroid, a few free hours, and a 
season pass to Disneyland—what 
better place to use the film than 
Disneyland? Polaroid film is no longer 
in production, so when you find a pack 
that still is actually good enough to 
use, you don’t abuse it. You choose 
your pictures wisely. As I made my 
way through the park picking the best 
ten spots for this pack, I came across 
Goofy. He was in front of the Tower of 
Terror, which seemed like the perfect 
backdrop.
 
I patiently waited in line with five-
year-olds who nearly wet themselves 
in anticipation of meeting and getting 
photographed with Disney’s reining 
king of silly. When it was my turn, I 
asked for just a picture of Goofy being 
goofy. 

He jumped up and down as I snapped 
a Polaroid of his goofiness.

As I turned to walk away, a cast member 
tugged at my arm. “Excuse me, miss?” 
The cast member said, “Goofy would 
like a picture as well.”
 
I turned and looked at him. His hands 
were begging, and then he used his 
oversized finger to take a fake snapshot 
of me.
 
My Polaroid is precious to me, and, as 
bitchy as it may seem, all I could think 
was Really, Goofy! Do you have any 
idea how much this stuff costs?!
 
I looked down at my camera; only 
two pictures were left! Two pictures! 
And I’d have to give it to a damn 
anthropomorphic dog!
 
But I obliged.

Grudgingly I took the photo; and 
joyfully, he took it from my camera—
yanking it—not even waiting for it to 
finish popping out.

I smile. I did my good deed. Then began 
to leave. This time Goofy stopped me. 
For a moment, I thought he was going 
to give me a hug.
 
No hug.



Goofy again gestured at my camera 
and made a mock picture sign. Then 
he pointed at his friend, and used his 
hands to beg.
 
Goofy was quickly becoming the 
Charlie Chaplin of dogs. And he was 
starting to get on my nerves.
 
Before I could even consider saying 
no, the Goofy’s cast member friend 
was clinging on him waiting for me to 
snap the picture.
 
Again, Goofy yanked the picture out of 
my camera and then he waved it in the 
air and gave the thumbs up sign to the 
crowd. A few people actually clapped, 
as Goofy put it to his chest like was his 
most cherished gift.

The thing was though…it probably 
was one of his most cherished work 
gifts. Polaroid—even today—has that 
magic.  Unlike digital cameras that 
can easily be deleted or reformatted, 
there’s something innocent about 
analog. It captures moments and tells 
stories in ways that digital photography 
simply cannot.
 
As digital cameras and gadgets attempt 
to make us drool at features, and make 
us completely forget the cameras that 
came before them, it’s worth it to take 
a moment and go down memory lane. 
To look at the rise and fall of one of 
the most iconoclastic films that ever 
graced the hands of photographic 
fanboys and fan girls alike.



Instantly Yours –
A Short History of Polaroid

The year is 1928. A nerdy 19-year-
old Jewish boy named Edwin H. 
Land sneaks into the science lab at 
Columbia University. He has little 
money. No reputation. And most of 
what he learns about science comes 
from the science books at the library. 
As his contemporaries bobbed their 
hair to jazz Jay Gatsby style, Land 
was learning to manufacture film with 
millions of polarizing crystals.

By 1932, Land had formed, with a 
Harvard physics instructor, Land-
Wheelwright Laboratories—which 
would later be renamed the Polaroid 
Corporation in 1937. Their most known 
product in this early day: Sunglasses.

It wasn’t until ten years later, that 
Polaroid introduced their must prized 
product: the instant camera (known 
then as the “Land Camera”). While only 
57 cameras were first manufactured, it 
quickly became an icon.

The Integral Film packs that most 
people would come to know (i.e. the 
some square, white bordered, black 
back, photos everyone over the age of 
25 has at least one of in their closet) 
were not introduced until 1972.

Polaroid Film was first called Roll Film; 
with roll film, the film basically would 
be pulled through rollers, which would 
pull the film over a chemical substance 

sx70 Pink Cool Cam



that is a piece of ham between two 
slices of bread (i.e. the exposed 
negative and the positive sheet); 
once the positive sheet was pulled 
away the picture would be revealed. 
It wasn’t exactly rocket science, but it 
also wasn’t quite as automatic as the 
cameras of the 70’s and 80’s most of 
us came to love.

Other companies would try to ride 
off Polaroid’s success—notably Fuji 
and Kodak (who was sued for patent-
infringement after the release of the 
Kodamatic, and, as a result, had to 
stop selling the camera)—but no one 
could ever capture the true beauty or 
perfection that made Polaroid great.

So what happened to Polaroid?

Its first slide was 1977; Polavision was 
introduced. It was to do to movies what 
instant film did to photography. Except 
it never caught on. Despite being 
used by the likes of Andy Warhol and 
Charles and Ray Eames, Polavision 
became a huge disaster—so great that 
Land would resign from the company.

Polaroid continued to sell instant film 
throughout the eighties and nineties, 
but the company, like so many other 
camera companies, did not realize just 
how great digital photography would 
be. By 2001, the company had filed for 
bankruptcy. For the next several years, 
its name was licensed to everything to 
DVD players to TVs. In 2008, it filed 
for bankruptcy a second time.

Neighborhood on Spectra

Star Tours

Florence Bike on Spectra



Today, Polaroid is just as relevant as 
ever—but no thanks to the company. 
While the company still struggles to 
find it’s mojo by getting the likes of 
Lady Gaga to advertise for them, 
fan-based organizations like The 
Impossible Project and New55project 
have helped make sure the film is not 
lost.

Azuree Wiitala, a professional 
photographer and an instant film 
enthusiast, shared her love for instant 
film in a digital age; 

“A huge appeal of instant film for 
me is that it is instant. I like that 
you can see something through 
a viewfinder, click the shutter and 
moments later have a reproduction 
of that sight in your hands. Not 
locked away on a file in a computer 
or on your phone, but in your hand! 
You can put it in a journal or frame 
it when you get home!! I remember 
resisting getting a digital camera 
until I had to remain competitive 
shooting weddings. It was so cost 
effective to shoot digitally but only 
a year or two later I was back at it 
with film in hand. I found digital 
images to be so lifeless and I seldom 
even looked back at the pictures 
after taking them. With instant film 
I have a box I can pull out and look 
at pictures from time to time. I like 
that. I am especially drawn to the 
square format of integral films and 
love that you have a little framed 
picture in hand!”

Like life, Polaroid represents something 
that digital never will—there is no 
delete button. Once you hit the shutter, 
the photo lives. The old cameras may 
be as high tech as a gadget comes but 
there’s no take backs or do overs. It’s 
a lost art. If you want to rediscover an 
important part of camera history, check 
out some of these female Polaroid 
photographers:

- Susannah Conway
- Anne Bowerman
- Jessica Hibbard
- Lauren Beachman

Scott on Spectra
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What’s in an

by Beca Lewis Skeels

Adventurer Photographer’s Bag

Now that you’re familiar with lenses from page 4, let professional photographer 
Beca Lewis Skeels advise you on what she carries in her bag for photo 
adventures. To familiarize yourself a bit more, click on the links for more 
information. 

If anything, I would certainly consider myself an adventure photographer. Sure, 
I photograph products, pets, and cake, but my heart is in climbing through the 
swamp, camera in hand, or shooting videos. We don’t have movie theatres, 
a mall or many paved roads, so this flash to the past has given me so many 
opportunities to cultivate my adventuring and my photography. I’ve learned to 
be both a minimalist and be prepared for whatever escapade awaits.



I don’t carry a full kit with me into the woods. I keep it simple. My Olympus 
EP-1 has recently been my go-to camera. It’s less bulky than my E-410 and 
the quality of the photos are par. It shoots incredible video, and there really 
is nothing like gorgeous video in the middle of the swamp. The best part 
about the EP-1 is that all of my DSRL lenses are interchangeable with the 
Lumix Micro 4:3 to 4:3 adaptor. My mandatory adventure lenses are the Bell 
and Howell Fisheye, the Olympus Digital 40-150mm long lens and Olympus 
Digital 14:42mm lens. I also keep a macro lens handy in case I come across 
some furry critters or itty bitty fiddler crabs looking for some portrait work.

When it comes to bringing light, I use a Sunpak 433 D and a Sunpak 544 as 
my kit flashes. Although natural light is my favorite, we tend to go out a lot 
during the evening, and flashes are key. I keep a soft diffuser on the smaller 
flash and a flash bracket on the other for versatility. For any adventure, I 
make sure to have a tripod and reflector 5-in-1 kit. I started using Manfrotto 
tripods when I was a videographer for PBS and love them. They are reliable, 
easy to carry and absolutely necessary. The SP Studio Systems reflector 
kit comes in handy when bringing light to some ones face under heavy tree 
coverage or bringing in more golden tones in a muted environment.

http://www.olympusamerica.com/cpg_section/cpg_archived_product_details.asp?fl=&id=1461
http://www.olympusamerica.com/cpg_section/cpg_archived_product_details.asp?fl=&id=1461
http://www.olympusamerica.com/cpg_section/cpg_archived_product_details.asp?fl=&id=1294
http://www.sunpak.jp/english/
http://en.wikipedia.org/wiki/Diffuser_%28optics%29
http://www.manfrotto.us/photo-tripods
http://www.manfrotto.us/photo-tripods


Whether you shoot in the woods or in a big city alleyway, having reliable 
waterproof boots is so smart! They’re also a pretty perfect accessory with 
skinny jeans and a parka! I also keep a few snacks, a heavy coat and a knife 
close by. Adventure photography is unpredictable, bring along extra batteries, 
charger, a power inverter to plug in the chargers, a heavy-duty flash light and 
cell phone.    

And of course, let’s not forget the bag I put it all in. I have several full kit 
packs, both soft and hard, but I love the canvas bag pictured for an afternoon 
tromping through muck. It’s easy to carry, comfortable and the extra front 
pocket is great for batteries and snacks. I don’t have to set it down to pull out 
any extra gear like my front zip photo backpack and I got this pack at the swap 
meet for $5, which means if it gets splashed with mud or ripped from cypress 
branches, I won’t be as bummed as I would be with the $200 pack. 

Whether I’m shooting an event, creating a series or just romping around, I like 
to be prepared. I have just about everything I need in this kit for a day in the 
woods, which gives me a lot more time to adventure!





If you’re on Instagram, Laura Lawson is a familiar name. If her name 
doesn’t come to mind, most likely you’ve seen her photos on the Popular 
Page more than we have followers, combined. Ok, so the numbers are 
exaggerated, but if Instagram is becoming a household name, so is 
Laura Lawson.

Gadchick Interviews:af ty
Laura Lawsonby Diana La Counte

LLWater by Laura Lawson



Tell us about yourself, and how long you’ve been on Instagram.

I am an artist, blogger, and Nutella lover based in the San Francisco area. Many of 
the images you see on my feed are homage to the beautiful part of the world I am 
blessed to call home. Instagram has certainly helped me see everyday life with a 
fresh perspective, and has changed the way I view my surroundings – which is what 
it’s all about in the first place. I defy monotony. I see everything as a composition. I 
should probably note that I am not a photographer, at least not in the traditional sense. 
I’ve always loved photography but have never really given it a chance, not wanting to 
be just another hipster with a DSLR. I posted my first Instagram photo on February 
7, 2011 while watching the Super Bowl. I had no idea what I was getting myself into 
back then, but it has truly opened my eyes to a world of creativity and inspiration. 
I love scrolling through my feed and seeing New York City through @chrisozer’s 
eyes, or @withhearts’ daily cup of coffee. I have become completely obsessed with 
photography and am just beginning to pursue it more seriously.

Instagram has opened up so many opportunities for you. Can you share your 
favorites? 

I have met so many amazing individuals through Instagram, many of whom I’ve had 
the privilege to meet in real life. I love social media for bringing like-minded people 
together from all across the world, and I am so indebted to Instagram for the friendships 
it has cultivated in my life with fellow nerdy iPhoneographers. In November, I was 
blessed to sponsor a clean water organization called Seeds Of Hope International 
Partnerships through an art show I held at a local gallery. I asked the Instagram 
community to get involved by posting pictures of people holding or drinking water 
and tagging the images #LLwater. I culled almost 400 pictures, which I printed and 
assembled into a giant photo collage for the show. It was fascinating to see people 
from all across the globe get involved in this project. The Instagram installation truly 
was the hit of the show, and sequentially I am planning a Hipstamatic/Instagram 
exhibit with a photographer friend of mine later this year.

It’s not a secret you suffer from retinitis pigmentosa. This is a sad relation; how 
has it changed your perspective on photography?

Retinitis pigmentosa, or RP, is an incredibly rare degenerative eye disease that is 
slowly robbing me of my vision, for those not in the know (look it up on Wikipedia to learn 
more). I was diagnosed two years ago while attending art school. The repercussions 
of this diagnosis stretch pretty wide… I was forced to give up driving, and had to 
accept the ugly reality that I may someday lose my vision entirely. Throughout my 
grieving and healing process, I have consistently relied on God for direction and 
strength. I have never lost my inspiration, it has just evolved. >>>

http://web.stagram.com/n/chrisozer
http://web.stagram.com/n/withhearts
http://www.sohip.org/
http://www.sohip.org/
http://web.stagram.com/tag/llwater/
http://en.wikipedia.org/wiki/Retinitis_pigmentosa


My #stuffonconcrete series on Instagram transpired through being stuck at home not 
being able to drive – I simply place objects on a concrete slab in my backyard and 
photograph them. I now find inspiration in cracks on sidewalks, birds flying overhead, 
suburbanites walking their dogs.  I have found a new normal. I see the beauty in 
everything and try to take nothing for granted. My entire worldview has shifted for the 
better. Yes, I would even go so far as to say that RP has been a huge blessing in my 
life.

How do you find inspiration through your iPhone camera?

Your best camera really is the one you always have with you, and currently, that’s my 
iPhone 4. I have learned about composition, color, lighting, and so much more simply 
by continuously snapping shots while on the go. The ease of access and excellent 
megapixel quality of the iPhone speaks for itself. It has essentially replaced the point 
and shoot.

Instagram is a breeding ground for spam, like every popular social media 
platform. How do you deal?

Ah yes, there is truly nothing more annoying than your average follow farmer roaming 
the halls of Instagram looking for the next photo upon which to spit up some spam. 
I know that the Instagram team is working hard on solving this issue, but in the 
meantime, it doesn’t bother me too much. In my free time I like to spam the spam 
along with my good friends @reelpeet and @colbruski. We’ve even gotten some of 
these kids to realize what they’re doing is obnoxious and to let their work speak for 
itself.

Bikes by Laura Lawson Fly Fly Away by Laura Lawson

http://web.stagram.com/tag/stuffonconcrete/
http://web.stagram.com/n/reelpeet/
http://web.stagram.com/n/colbruski/


What’s your favorite photo from Instagram and the story behind it?

Man, what a question! I had to think long and hard about this one. The first shot that 
comes to mind is from a recent Instawalk in San Francisco that some friends and I 
planned. We were overlooking the Golden Gate Bridge and I had the bright idea to 
have all the iPhonegraphers line up and pretend to take a picture in the same direction. 
It turned out to be a hit, so much so that Instagram asked if they could use the photo 
as a permanent banner on their blog (I said duh). To me, the photo represents what 
Instagram is all about. The other image that immediately comes to mind is a good old 
fashioned #fromwhereistand photo with my dirty white TOMS in front of a giant pile of 
all the printed photos from my #LLwater project on the ground. I had just received the 
photos from Printstagram in the mail and was so excited to feature them in my show 
that I simply dumped them everywhere and captured the moment without thinking. I 
have found that spontaneity and those unplanned serendipitous moments often give 
birth to the most unforgettable images.

Any wishful thinking for new features on Instagram?

I love it exactly the way it is. I do miss the old tiltshift, but once the Rise filter was 
introduced, Instagram peaked.

>>>

Emoji from 1930s by Laura Lawson Follow Your Heart by Laura Lawson

http://blog.instagram.com/post/18031665339/instameet-tips-icebreakers


Instawalk by Laura Lawson

What annoys you on Instagram?

Well, the spam is extremely annoying of course. I suppose the Popular Page annoys 
me as well. I never look at it if I can help it. I’ve seen enough cleavage and pictures of 
celebrities to last a lifetime, thankyouverymuch. I don’t like overly processed photos. I 
usually just edit my photos in one Instagram filter. I like to keep it clean and simple and 
can’t stand anything resembling HDR. I only follow people whose work is exceptional 
and inspiring, or if they are my good friends in real life, so I am guaranteed to double 
tap pretty much every photo I see whenever I scroll through my feed.

Laura Lawson’s Instagram and blog. 

http://web.stagram.com/n/lauralawson
http://lauralawsonart.com/blog


Instagram is one of the most popular apps in the App 
store and it has its own verb now (“Instagraming”, 
“Instawalk”, “Insta-insert verb here”). There are over a 
dozen tech articles claiming Instagram will be available 
on Android this year. Let Laura Lawson, the Instaqueen 
(sorry, Laura, but you’re royalty to us in Instagram), 
share her best tips for what Apple named App of the 
Year for 2011. 

The best advice I would give to a fellow Instagram addict, or artist of any kind, is 
learn how to edit your work. Only select the very best. This will train your eye to 
see things in new ways. People will be drawn to your work when all they see are 
outstanding images. And yes, it is completely all right to post a self-portrait from 
time to time… as long as you’re not using the front facing camera.

I’m most attracted to organic shapes and contrasting textures. I think that’s partly 
where my #stuffonconcrete series came from – fruit just seems to stand out 
nicely against pavement. I love simple, bold shapes that communicate clearly. 
Lately, I have been trying to post more landscape/street scene shots. I never 
want to get stuck in a certain mode; I always want to be evolving as an artist and 
challenging myself. I do have a particular style however – I am not as drawn to 
symmetry or hard lines, for example. I love photographing people and making 
my friends pose against interesting walls.

I am extremely picky when posting photos to Instagram. I take dozens of pictures 
every day, but only a few make the insta-cut. Friends chastise me, saying I 
should feel free to post whatever I want, since after all this is simply nothing 
more than a virtual diary of my day-to-day life. And while I know that’s true, I still 
don’t want to lose photographic integrity. What I look for in a post-worthy photo 
is a straight horizon line, perfect crispness (lately I’ve been shooting in HDR 
mode), and a good crop.

One reason why I love mobile phone photography is the large number of readily 
available photo editing apps for the iPhone. I have over 40 photo apps myself, but 
the two that I use almost exclusively are Filterstorm and Camera+.  Filterstorm 
is fabulous for sharpening, straightening, brightness, and white balance control. 
To be honest, most of my Instagram shots are only edited with one Instagram 
filter – I use Valencia and Rise more than any others – but if a shot needs a 
little tweaking, Filterstorm is my go-to app. Camera+ has some really fun retro 
looking filters that I will use on occasion. Another thing I love about both these 
apps in particular is they will save the photo’s geotag, unlike most other photo 
editing apps.

http://web.stagram.com/tag/stuffonconcrete/


Going Digital: My Love Affair with the Pixel
by Diana La Counte

I remember like it was yesterday. 1996. A new fancy gizmo called the DVD 
launched in Japan; Internet Explorer 3 was the advanced browser; P.G. 
Wodehouse rolled in his grave as Ask Jeeves became an Internet sensation, 
and I got my first digital camera! 

To be more precise, I got an Olympus 
C800L. This love of my shutter happy fingers 
boosted the latest and greatest in digital 
technology—.81 resolution, a LCD screen, 
built in memory (that’s right readers, no 
fancy SD slot for me), and…well that’s about 
all it boosted, but it was 1996, and I couldn’t 
exactly be picky. Olympus C800L

My next camera came in 1998. It had the 
best specs! It had over 1 megapixels- 1.2 to 
be exact. It was an Epson PhotoPC 750Z 
(I’m not joking, Epson actually made digital 
cameras back in the day). This bad girl had 
a 3x optical and could even make grainy 
8x10 quality prints! Oh! Did I mention the 
expansion slot?! It had a slot for Compact 
Flash—which was all the rage back before 
SD cards ate them alive.

Epson PhotoPC 750Z

Over the years, I’ve gone through Kodak’s, Canon’s, Samsung’s, and too many 
others to even begin to count. Why? I love digital.

Every super hero has its origin story, which makes me wonder: what’s the 
digital camera origin story? 



Like most origin stories, digital got its powers at the height of the Cold War 
during a radiation leak at an über secretive U.S. Spy facility that nobody 
knew existed…okay, okay, so the story wasn’t that sexy, but it was still the 
Cold War: 1975 to be exact. The first attempt at digital was a prototype that 
Kodak worked on. It weighed eight pounds, had a 0.01 (Yes! 0.01, which also 
marked it as the only digital camera worse than the camera found on the 
iPad 2), and took 23 seconds to record an image. Throughout the eighties, 
a number of companies experimented with digital, but, push come to shove, 
they were more like video cameras with the ability to capture a still photo.

Kodak’s 1975 Digital Camera Prototype 
(Photo Credit Kodak)

The cost of early digital cameras (around $20,000) kept most of these 
cameras out of consumer’s hands. Mostly they were used by newspapers, 
who needed a way to transmit images to their respected news outlets without 
satellites—it was used heavily during the 1989 Tiananmen Square protest 
and also the Gulf War: Part I (not to be confused with the sequel). To put it 
in today’s terms: Digital cameras were sort of the Twitter of 80’s/90’s political 
conflicts—it fed us with images almost instantly.

Fuji takes credit for the first “true” digital camera with the Fuji DS-1P in 1988. 
It was never manufactured in the United States, however.

Fuji DS-1P



Throughout the nineties, there was a digital age war on as iconic companies 
like Nikon fought to stay relevant. Apple even had its hands on digital with 
the QuickTake (spoiler alert: it wasn’t as quick as the name implied). It wasn’t 
until the late nineties, when digital cameras finally started reaching a price 
point that consumers could actually afford, they really started taking shape.

While some companies lived on, others simply found no way to recapture 
the glory days of film. Kodak—a company that once represented America’s 
love affair with point and shoot—is perhaps the most tragic example of when 
digital attacks analog. Sure they had digital cameras, but so did just about 
every other tech company. Innovation is what mattered, and their lack of 
timely innovation unseated them from their place on top and they never quite 
recovered. 

In 1997, Kodak traded on the New York Stock Exchange for $90 dollars; today? 
It just went bankrupt. The company that gave the world the first prototype of 
the digital camera, and once controlled a whopping 90% of the U.S. camera 
hungry hands, is now on life support, and simply waiting for someone to pull 
the plug. 

The real winners of the digital age are the consumers, who can demand 
innovation. In the digital age, brand name is not nearly as important as 
features. Before I leave you, stroll with me down memory lane, at a look at 
ten of the craziest, funniest, oddest, and downright innovative digital cameras 
to ever hit geek hands:

Yes, Apple had a digital camera. Its name 
was the QuickTake and it was released 
before Steve Jobs returned the company 
to innovation, but after John Sculley had 
been ousted. It cost $750 dollars (and you 
thought iPad’s were expensive!), and was 
launched in 1994. It had a 0.3 resolution, 
and only released one model compatible 
with Windows. It was around for three 
years, but was discontinued in 1997. It 
wasn’t exactly an innovating camera (it is 
considered one of Apple’s greatest flops), 
but it was a clear sign of what was going 
to come for cameras.

Apple QuickTake 100



Seitz 6x17 was the camera for boys trying 
to compensate for something they lacked. 
It’s resolution? 160 megapixels! That’s not 
a misprint! When most of today’s cameras 
barely hit 15 megapixel, this camera, 
released in 2006, proved that some camera 
makers preferred to reach for the sun and 
not the sky. Why haven’t you heard of it? For 
starters, it cost about $35,000. And, in case 
you are wondering how big a 160 MP picture 
is—it was nearly 1 gigabyte.

Seitz 6x17

Back in 2006, when most camera makers 
were abandoning their analog cameras, 
Leica had a revolutionary idea—make an 
attachment for analog cameras to make 
them shoot in digital as well. It was heavy, 
expensive ($5,000), and had a resolution of 
10MP. It was also Leica and crazy cool. It 
proved you still could have the best of both 
worlds. Leica Digital Module R

Minolta had a crazy idea in 1998--why not let people shoot in absolutely any 
direction? It was possible with the detachable lens on the Minolta Dimage 
V. Through a special cord, users could detach the lens from the body of the 
camera and take a picture at literally any angle. It had an original price of $700, 
had a 2.7x zoom lens, and could hold whopping 32 pictures—okay, okay, the 
specs aren’t amazing, but it had a sweet detachable lens!

Minolta Dimage V Konica Kanpai



Imagine a camera that could get those rare family moments when people 
actually laugh! Okay, so this one isn’t a digital camera, but it was definitely 
innovating. The Konica Kanpai was a voice activated camera that would 
atomically turn its cute little bod (did we mention it had a built in tripod?) 
around whenever it heard people laughing, and take a picture.

What would a list of crazy, fun 
and innovating digital cameras 
be without at least one that made 
you say “Aww!”? Meet the Necono 
Digital Camera. The Japanese 
camera had an original U.S. price 
of $191. With a lens hidden inside 
the eye, the adorable 3MP camera 
made the ultimate spy camera (no 
one ever suspects the cat). Necono Digital Camera

There are several ways to make 
headlines, but the easiest is breaking 
a record. This camera did just that with 
what they bill as the “World’s Smallest 
Camera.” It suffers from perhaps one 
of the most uninspired names (really? 
“The World’s Smallest Camera” was 
the best name they could think of?), but 
it’s still impressive. Measuring at 1 1/8 
in length and 1 1/16 in width, the finger 
size camera weighs just 1/2 ounce. 
The camera comes short in terms of 
megapixels—only 2 megapixels—but 
it does have the ability to record video 
and can even save photos on a microSD 
card. The camera can still be purchased 
on Hammacher Schlemmer’s website 
for $59.95The World’s Smallest Camera



If you ever want to create true panoramic 
photos, then you’ll need to check out 
this camera. The Giroptic 360° has 
corned the market on 360° cameras—
but at $699, be prepared to shell out 
cash to experience its innovation. 
The camera is perfect for real estate 
agents wanting to dynamically show 
off a house, but until it gets a price cut, 
it’s not quite ready for primetime.

Ok, so the Giroptic doesn’t control 
all the 360 market—but it is the most 
professional one. If you are looking for 
a toy, check out the The Dot iPhone 
Panorama Lens, which is available for 
a fraction of the Giroptic’s price (just 
$79).  And speaking of the iPhone, 
head to PhotoJojo and see the latest 
and greatest in iPhone attachment 
lens’.

3D…you had us at Avatar! But then 
you had to go off and shove it down our 
throats in everything from TVs to Video 
Games—and, of course, cameras. 
Fuji beat everyone when it released 
the FinePix REAL 3D . The camera 
not only shoots in 3D, it records in 3D 
as well. If you are one of the millions 
gaga for 3D, then this camera is for 
you.

Digital is constantly changing and by the time this goes to print, there will be a 
bigger, better and more impressive camera than the newest camera models 
mentioned. I may not always catch up with it, but looking back at my Olympus 
from 1996, I can’t wait to see what else comes next.

Giroptic 360°

The Dot iPhone 
Panorama Lens

FinePix REAL 3D



Embracing Your Self Portrait

I like being single.

There I said it. 

People always scoff at that. “Incredulous. Incredible.” But I do.

Are there moments I long for companionship? Absolutely. 

For the time being I like climbing into my own bed each night, not fighting for 
cover space or the right side of the bed. 

There are certain perks to being young (relatively), single (very), and good-looking 
(moderately) in New York City. Free food, drink, memoir-worthy adventures, and 
love affairs that begin and end in a single smile on subway platforms, in coffee 
shops, or standing just next to the Hudson river.  

The problem begins and ends, as a single woman and blogger, in photography. 

by Meg Fee

Photo Credits: Meg Fee



Let’s lay it out there: photography is key. It elevates and enhances a blog. Provides 
immediate interest. And the people want, what the people want: photos of the 
gal behind the blog.

I just need an extra set of hands sometimes. And a boyfriend would do nicely for 
this. I know, I know, a boyfriend for the sole purpose of taking my photo? Sounds 
so narcissistic. So instead I trade one narcissistic trait for another- taking photos 
in the bathroom mirror. With camera in hand I fire away. For every ten pictures I 
take, there is one that I find acceptable. 

When not at home there is the iPhone (or smartphone). It’s a single ladies best 
friend: pictures and directions. I employ the little flip of the camera and fire away. 
Sure there’s that awkward moment when the photo rights itself and I think, Oh 
dear Lord, is that really what I look like? The feeling usually passes when I filter 
the photo through instagram, choosing the setting the washes me out the most. 
The more the “washed look” the filter has, the less the fine-lines and the better 
I look.



Self-portraiture takes both fearlessness and an inflated sense of vanity. It’s a 
bit more serious than that. You see, there was a large chunk of my life during 
which I was afraid to have my photo taken. I hid from cameras. Whole years 
of my life went undocumented. There was the constant fear- at the end of the 
night someone will pull out a camera, and no one should live in that type of fear. 
Having your photo taken and being okay with the image--well that just takes 
some time, a little knowledge, and some practice- the image is not quite you. 
It can be both alarming and disarming. Once you accept that--that an image 
is inherently distorted and you might like what the camera reflects back. Once 
you make peace with this, there is a freedom- freedom from fear. Freedom from 
thinking the camera tells the truth. It doesn’t. It’s still valuable and still a hell of 
a good time. You’ll never look exactly the same, and sometimes it takes a good 
hundred pictures before you find one you really love. And to learn these things, 
to really know them in your body, that takes practice and time. And for me, I 
found that freedom by taking silly self-portraits- photos for my eyes alone. It’s 
there in my own makeshift-studios (mostly in bathrooms) I found some release. 
It was there I came to accept my face in pixilated form--sometimes chubby, 
sometimes thin, sometimes luminous, and often tired. It was there I practiced 
the art of seeing the big picture: screw the plumpness of my face, but do I look 
happy? This may not sound like much but it makes all the difference in the world. 



Photo Credits: Meg Fee



How To

by Chantilly McKinnon

Photograph a Kid
You are planning a session of child-focused photography and you think, “it’s 
going to be a breeze – maybe even fun!”   You will keep the shoot short, snap a 
few photos and come out with some brilliant snapshots that perfectly capture the 
essence of childhood.  Kids are naturally adorable after all, so it won’t take that 
much work, right?  If you have ever thought such a foolish thing then it is clear 
that you have never witnessed the spark that is ignited the moment that most 
children spot a camera.  A simple child portrait can devolve into a screaming, 
spit-frothing, mind-numbing mess so quickly that it’s not hard to understand why 
many are reluctant to mutter the phrase “Say Cheese” ever again.

However, if you’re one of those sweet, naïve individuals (or perhaps brave and 
foolhardy types) that want to give this unrecognized sport a try then I have a few 
pieces of advice for you. There has not been one moment in my life that I have 
ever considered myself a professional anything so please don’t believe that I 
fancy myself an expert. However, I do lord over one of the most energetic and 
possibly defiant two year olds I have ever met and I have a decent track record 
of taking photos that I will love – or at least appreciate – until the end of time.

Tip One:  Leave the building

Natural light is the best light so if you 
can get outdoors.  If you’re working 
with a very bright day it will be better 
to have your subject stand in a more 
shaded area so you can avoid having 
the sun shining in their eyes and a 
washed out complexion.  This will help 
you get a beautifully lit and much more 
natural feeling photograph.

6 months by Chantilly McKinnon



Tip Two:  Keep shoot ing

Set your camera to continuous shooting and get ready to take about a bazillion 
shots.  Child photography may burn through the aperture life of your camera 
but it’s worth to catch those in-between moments.  Kids are wild, crazy animals.  
Let them do what they do best and you are bound to get something golden 
on film.

Real life reaction by Chantilly McKinnon

Tip Three:  This is going to take a while

Natural light is the best light so if you can get 
outdoors.  If you’re working with a very bright 
day it will be better to have your subject stand 
in a more shaded area so you can avoid having 
the sun shining in their eyes and a washed out 
complexion.  This will help you get a beautifully 
lit and much more natural feeling photograph.

On the pot by Chantilly McKinnon



Tip Four:  The Rubber Duckie will make you or break you

It’s all sorts of cliché when you imagine the photographer perched behind 
the tripod waving around a rubber duck in hopes of catching a smile.  It must 
have worked at some point but when you are imagining this scenario you can 
hear a kid crying, right?  Bring along some fun props to the shoot but don’t 
expect them to be the backbone or the theme.  Tread lightly and don’t force 
it.  You can never tell how a child will react to a certain toy on a given day but 
it may work.  Props like eye masks and super hero capes are amazing visual 
elements. 

Little geek by Chantilly McKinnon

Tip Five:  Near and Far

Close ups and wide-angle shots are both key to telling a tale.  Get all up in that 
kids business to catch the nuances of their expression and keep the frame 
wide to keep the story going.  If you are shooting with a DSLR and you don’t 
have the budget to invest in a fancy lens then I’d suggest finding a filter kit 
on eBay or Amazon.  All you do is screw on an adapter ring and you can use 
tones of different filters.  My favorites are the macro and wide angel variety.  
Plus these babies are usually less than $20 and get you something akin to a 
big dollar lens.  Sweet!



Blocking the sun by Chantilly McKinnon

Tip Six: Get small

For the most part when I’m taking photos 
of my daughter I am at her height level.  
This in turn means that I look like a moron 
for the majority of the time I’m shooting.  It 
also means that I get grass stains in the 
summer, snow soaked pants in the winter 
and caked with mud the rest of the year.  
Maybe the tip should have been to bring 
a change of clothes.   Regardless, taking 
photos at your subjects level is yet another 
way to make the picture more natural and 
to add more personality to the composition.   
Photography that is shot from an odd 
angle often leaves me thinking about the 
position of the photographer rather than 
the subject in the photo. 

On her level by Chantilly McKinnon



Tip Seven: Photoshop that kid

This tip may seem evil but it’s not, I swear.  Photoshop gets a bad reputation 
because of its truly transformative and sometimes deceptive abilities.  I’m not 
here to tell anyone to wipe away the freckles and Kool-Aid mustaches.  What 
I love about Photoshop the most is something commonly known as actions.  
A Photoshop action is originally created when one kind soul has taken the 
time to turn a very long image altering process into a one click action.  That 
action allows the user to create any variety of photo effects or filters – similar 
to Instagram.  I tend to favor those with a vintage feel to them and I have 
had great success with products from Paint the Moon and Michelle Nicole.  
Seriously, its one quick click and it can add a whole new feel to an image.

Hannah by Diana La Counte



Bonus Tip: Have Camera, Will Travel

I have a serious appreciation for all of the little humiliations that childhood 
brings.  The problem is that most of these magic moments don’t happen 
during a scheduled photo shoot.  This is exactly why my iPhone is so close to 
my heart.  It has a good camera and it is always by my side.  Don’t forget to 
remember to pull out your photo for a quick snap when your child busts a can 
of tomato sauce at the grocery store, gets their head stuck in the monkey bars 
or falls asleep on the pot.  Sure, they will hate you for it for years but at least 
you have the funny picture.  

This is as far as Gadchick can help you when it comes to photographing kids. 
As for the tantrums and broken camera from that photoshoot, we are not 
responsible! 

Obligatory scream shot by Chantilly McKinnon



How to Photoshop Your Ex 
Out of Photos & Other Tips

by Erin Micheletti

Photoshop Retouching 101

Open a magazine, look at a billboard or simply walk down the street and it’s 
hard not to come face-to-face with a Photoshop disaster. Hands turn into mutant 
prongs, arms are erased, and skin is airbrushed clear off faces.

Photoshop is great for many things – you can crop, resize, color correct and 
get all Perez Hilton with your pics to your heart’s content. But what if you need 
to actually – gasp – retouch an image? Is it possible to fix a bad skin day while 
still looking normal? What about removing your ex-boyfriend from your vacation 
photos? GadChick is here to help. 

Don’t have Photoshop? Never fear – GIMP is a free, open-source download that 
offers many of the same benefits as Photoshop, but without the crazy price tag. 
While the program is a little rough around the edges (it’s open source and not for 
profit, after all), the basics of these tutorials are also applicable to GIMP. 

Ready to say goodbye to acne and ex-boyfriends? Here’s how to touch up your 
photos without turning them into your own little Photoshop of Horrors.

Basic Color Adjustment

The first step to fixing an image is to be sure that the colors are balanced. Why 
does this matter? With the wrong color balance, your pearly whites can’t sparkle 
and your skin will look washed out (or gangrene, as the case may be), a color 
problem that all the skin smoothing in the world can’t fix. Fortunately, many 
of the problems with colors are due to a general color shift. What this means 
is that there is simply too much of one color in your image, or not enough of 
another color, depending on how you want to look at the balance problem. For 
Photoshop newbies, the color balance tool is the easiest to use and understand. 
(For more advanced users who play with levels and channels – feel free to skip 
ahead to our skin retouching how-to.)

http://jezebel.com/photoshop-of-horrors/
http://www.gimp.org/


Step One: Create a Color Adjustment Layer

1. Go to Layers -> New Adjustment Layer -> Color Balance
2. You’ll see this Color Balance window:

As the name implies, color balance is all about 
balancing the relationship between different 
colors. For all the non-art majors out there, each 
additive primary color (red, green, and blue) has a 
complementary subtractive color (cyan, magenta, 
yellow). Adjusting the amount of each color by 
adding or subtracting can help color correct images.

3. Play with adjusting the sliders to see how more 
or less of one color affects the overall colorcast. In 
this example, the image has too much cyan and 
yellow. Adjusting the sliders brings the image back 
to balance.

As a word of warning, every monitor is calibrated 
differently, so be sure to check your settings before 
getting started. While unlikely, there’s nothing worse 
than color correcting a bunch of images only to find 
that your monitor display is completely off.

Step Two: Create a Brightness/Contrast Layer

Sometimes, images will appear washed out. This 
is a common problem in landscape photography 
and even every day point-and-shoot snapshots. 
Depending on the quality of your camera, bright 
sunlight may simply overwhelm your camera’s 
ability to accurately meter the scene, causing you 
to lose detail in your sky and color intensity. Adding 
a brightness/contrast layer is an easy way to bring 
back your photo’s vibrancy.

In our example photo, you can clearly see how color 
adjustment and brightness/contrast adjustments 
really bring the image to life! On the left is the 
original image; in the middle is the image after color 
adjustments, and on the right is the image after 
brightness/contrast adjustments. Just a few easy 
tweaks and your photo will go from blah to wow!



original  after 
colour adjustments

after brightness/contrast 
adjustments

Basic Skin Retouching

Now that your colors are set, it’s time to get to the fun stuff – aka the retouching 
that most of us think about when we hear the phrase, “Can you Photoshop me?”

The first step in skin retouching is to remember the old adage: “Less is more!” 
Read, repeat, and take this to heart! When it comes to removing fine lines, 
freckles, or acne, tread lightly. And remember; zoom out from your image every 
so often to see the impact that your change has made. When we’re zoomed in 
close, it’s easy to go overboard on the edits. The goal is natural – not a forehead 
that’s been smoothed to within an inch of its life! 

In this example, we’re using an un-retouched image of Angelina Jolie – because, 
hey, even the beautiful people need a little help looking like stars!



Step 1: Create the effect

1. Open your image. Keep in mind that you’ll have better success with natural 
retouching when using a high-res image so the detail of the skin can really be seen

2. Create two duplicate layers (Layer -> Duplicate Layer); rename the top layer ‘High 
Pass’ and the middle layer ‘Low Pass’; we’ll work on the low pass layer first, so click 
the eye next to the high pass layer to hide it

3. For the low pass layer, we’ll be using the surface blur filter. Go to Filter -> Blur -> 
Surface blur

The first step in skin retouching is to remember the old adage: “Less is more!” Read, 
repeat, and take this to heart! When it comes to removing fine lines, freckles, or 
acne, tread lightly. And remember; zoom out from your image every so often to see 
the impact that your change has made. When we’re zoomed in close, it’s easy to go 
overboard on the edits. The goal is natural – not a forehead that’s been smoothed to 
within an inch of its life! 

In this example, we’re using an un-retouched image of Angelina Jolie – because, hey, 
even the beautiful people need a little help looking like stars!



Step 2: Add back details

Next, we’ll work on the high pass layer, 
adding back skin details like pores and 
minor imperfections. 

1. Activate the high pass layer by clicking 
the eye on the layer box, and change the 
blending mode to Linear Light and the 
opacity to 50%

In non-Photoshopped images, natural 
bumps and pores are most visible on the 
lighter parts of the skin. We’ll use a layer 
mask to “add back” these natural details.

2. Go to Layer -> Layer Mask and select 
‘Reveal All’
3. Use the Apply Image tool (Image -> 
Apply Image) to apply a copy of the image 
to the layer mask; select background from 
the layer drop down menu
4. Now that the layer mask has been 
created, reactivate the High Pass layer by 
clicking on its thumbnail
5. From Filter -> Other select ‘High Pass’
6. Slowly adjust the radius until the skin 
looks natural; in the example below, we’ve 
kept the fine line around her smile

The Surface blur filter is controlled by 
managing radius and threshold. Radius 
specifies the size (radius) of the area 
that is sampled to create the blur, while 
threshold defines which pixels will 
be blurred. Pixels with a tonal value 
differences less than the threshold will not 
be blurred. Not sure what all that means? 
Do the following:
• Lower threshold until the edges just 
become sharp
• Adjust the radius so that the skin is 
smooth



7. Tweak the layer mask settings: click on 
the layer mask thumbnail to activate it and 
go to Image -> Adjustments -> Brightness/
Contrast
8. Tweak the brightness and contrast so 
that any skin imperfections are slightly 
visible in light areas and not visible in dark 
areas

Step 3: Smooth only the skin

Now that the skin is smooth, we have a 
slight problem – the entire image is also 
smooth. While this smoothing effect is 
less noticeable in an image with a soft 
background (like our example), all-over 
smoothing will really stand out if you have 
other people, objects, houses etc. in the 
background. Using the layer mask tool, 
we can erase the effect from unwanted 
areas. 
1. Group the top to layers (Low Pass and 
High Pass)
2. Add layer mask: Layer -> Layer Mask 
-> Hide All
3. You will now see the original image 
minus any skin smoothing effect
4. Add a new layer above the high pass 
layer and fill it with red; change the opacity 
to 50%

5. Select the group layer mask and “paint 
on” the skin smoothing effect
6. Start with a larger diameter and then 
fill in smaller spots using a smaller brush 
size
7. Once you have “painted on” all the skin 
smoothing, simply delete the red layer

Ta-da! Minor blemishes are gone, skin is 
smooth and your face will glow just like 
Angelina Jolie’s now does – rather than 
looking like a creepy plastic Barbie doll. 
In our example here, you can really tell 
the difference made when we added back 
subtle skin details.



Original Photo: Note the uneven forehead 
tones, faint bags under the eye, and fine 
lines on the face and neck.

Initial Retouch: How creepy – she’s 
turned plastic!

Final retouch: Minor fine lines are back, including the natural 
lines along her face when she smiles; skin is still a smooth, 
even tone



Boyfriend-be-gone: People (and Object) Removal

You blocked him on Gchat, defriended him on Facebook – now save your 
photos and remove your ex from your vacation memories. Removing people (or 
background objects) takes finesse. Like skin retouching, it’s best to make a few 
edits and take a step back to look at the bigger picture. Photoshop offers several 
tools for removing objects – often a combination of these is most effective for 
creating a realistic image.

Step 1: Content Aware
If you have a big object to remove (i.e., your ex-boyfriend), your first stop is “Content-
Aware”, a new feature introduced with CS5. In this example, we’ll imagine that Brad 
Pitt and Angelina Jolie are no longer together – and an angry Angelina wants to 
remove Brad from all the family photos.

1. Select the object/person using the lasso tool; selection can be rough – there’s no 
need for precision
2. Go to Edit -> Fill and select “Content Aware” from the drop-down menu
3. Ta-da! Photoshop will perform a bit of magic and remove the object for you

As seen here, the removal won’t be perfect, 
but a little touch up action will finish the job.



Step 2: Correct Textures

Content aware may not be perfect, but it 
gives you a good starting point for removing 
pesky objects and people. Our next step 
is to fine-tune the removal by correcting 
background textures.
1. Sample a portion of your background 
image using the Marquee Tool
2. Go to Edit -> Define Pattern to create a 
pattern from the Marquee selection

3. Click and hold down on the Clone Stamp 
tool until you are able to select Pattern 
Stamp Tool

4. Select your newly defined pattern from 
the options box at the top of the screen

5. Choose a soft brush to “paint” on this 
pattern
6. Go to Select -> Deselect to be sure the 
Marquee Tool is no longer active
7. Smooth your background using the 
Pattern Stamp Tool
8. If distinct lines appear from repeated 
texture elements (as they do in this 
example), toggle the ‘Aligned’ option on 
and off
9. If you have a complex background, you 
may need to define multiple pattern areas

Step 3: Recompose the Image
In this example, we removed an entire 
person, leaving the image off balance. 
If the image looks awkward after your 
object removal, simply use the crop tool 
to recompose your image and restore 
photographic balance – just as if the 
original person or object were never there.
Ciao, Brad!

Once you master the basics of retouching, 
let your creativity run wild! The Internet 
is packed with great tutorials for creating 
composition images and adding fun filter 
effects. We love Pugly Pixel’s tutorials. 
Experiment, make mistakes, but please… 
no claw hands

http://www.puglypixel.com/


Advertisement

find gadchick on:

twitter
facebook
instagram
google+
tumblr

&
subscribe to our blog 

http://www.heroingeek.com
http://twitter.com/Gadchick
http://www.facebook.com/GadChick?ref=ts
http://web.stagram.com/n/gadchick
https://plus.google.com/101216604608573737019
http://gadchick.tumblr.com/
http://feeds.feedburner.com/gadchick


gadchick reads
Edited by Annalee Newitz and Charlie Anders
Reviewed by Mandy Curtis

There’s no right way to stereotype a geek

I’ve long considered myself a geek. When I first 
started reading She’s Such A Geek, however, 
I wondered if I, like the many butts of the Inigo 
Montoya “You keep using that word. I do not 
think it means what you think it means” meme/
joke, had been using it wrong all along. I tend to 
use the word geek somewhat interchangeably 
with nerd, regardless of the view that they’re 
quite different. (See www.geeksaresexy.
net/2012/01/04/geek-vs-nerd-the-infographic 
for an example of the “differences.”) The farther 

I got into the book, I realized I just hadn’t yet hit the section that connected more with 
my type of geekiness.

She’s Such a Geek is a series of essays written by women of a variety of ages about 
their lives and various geeky pursuits. The book is divided into six sections—Growing 
Up Nerd; High Tech; In The Lab; Geek, Interrupted; Games; Superheroes—which 
loosely envelop the essays contained within. The first few sections, although they 
include interesting stories, didn’t really catch my interest. Don’t get me wrong. I, too, 
spent time enjoying math and science when I was younger, and certainly could have 
been considered a geek in those subjects along the way. (I was placed in eighth-grade 
science when I was in seventh grade and was one of five students who attempted AP 
Calculus in senior year of high school.) I just haven’t delved into those subjects in at 
least a decade, and I therefore had trouble fully connecting with women whose lives 
revolve around math, science and computers. (Mine currently revolves around grammar, 
Journalism and eagerly awaiting the release of Mass Effect 3 and The Avengers.)

I also think I would have enjoyed the book more had it had a more positive outlook on 
the whole. Like I mentioned above, I see myself as a geek. At times I’ve struggled to 
find my place in this oft male-dominated culture. But even in the essays with happy 
endings, it seemed less “this is a worthwhile struggle” and more “damn the (literal) 
man!” Many of the women who wrote the essays were born in the 1970s; I was born in 
1983. Was there such a drastic shift between Generation X and Y that I dealt with less 
geeksecution (geek + persecution) growing up? Or was my path just easier than most?

www.geeksaresexy.net/2012/01/04/geek-vs-nerd-the-infographic
www.geeksaresexy.net/2012/01/04/geek-vs-nerd-the-infographic


Two other cons: A lot of the essays could have used a revision keeping in mind the old 
“show, don’t tell” adage. Which, I’ll give them, is hard to do in a personal essay. And it 
might be just me—I’ll admit to being a bit of a square—but at least one of the essays 
seems to have been included for shock factor. I felt really uncomfortable when I started 
reading “The Hacker’s Guide to What’s In Her Own Panties” during my lunch break at 
work, and not just because I despise the word “panties.” (I finished the essay at home.)

That said, reading about other women who have similar interests to me is always 
entertaining, and there are a lot of good, thought-provoking bits to be found in the book. 
Including:

“The idea of a female geek seems to be a stereotype buster. But in fact, the figure of the 
female geek reproduces and reinforces all the negative stereotypes about individuals 
with an affinity for technology. And because she needs a modifier (female geek) while he 
does not (geek), she also reinforces the primary notion that technologically competent 
people are male.”—Suzanne E. Franks, “Suzy the Computer Versus Dr. Sexy”

“Math itself, I believe, is gender neutral. … That said, human are still shaping the study 
of mathematics, and humans have been socialized with certain behaviors and idea 
about things like gender. So while math itself may be free of gender bias, the way we 
practice it is not. It’s harder to see now, and people may not know they’re doing it, but 
it’s still there.”—Elisabeth Severson, “{Women} ∩ {Mathematics] = [Me, At Least}”

“Big boobs, big guns, and battles skills on characters like Lara Croft create a loose 
but positive association between women and games. Add this to the perceived rarity 
of girls who like games, and you have an instant recipe for female idolatry among 
the male gaming population (especially potent if you factor in the chivalry that role-
players typically carry in their pockets). It’s ironic to think that what some call sexual 
objectification of women in games might actually, under certain circumstances, have 
contributed to the empowerment of women gamers.”—Morgan Romine, “Fantasy to 
Frag Doll: The Story of a Gamer Princess”

“Boys get better fantasy lives. Go steal them.”—Quinn Norton, “Dreaming in Unison”
“I call it the ‘girl takes off her glasses’ myth: Women are viewed as either smart or sexually 
appealing. … This myth is one of many impediments preventing the current male-
dominated nerd establishment from mentoring young women. With some exceptions, 
men fear their colleagues will assume they’re sexually infatuated with the women they 
advise. At the same time, women fear that they’ll be accused of using their feminine 
wiles to win male mentors. … We all need to get over our fears and prejudices if we’re 
going to invent a quantum computer that works, if you know what I mean.”—Annalee 
Newitz, “When Diana Prince Takes Off Her Glasses”

Definitely worth a read if you’re looking to commiserate with your fellow geeks (of the 
lady variety) or gain some insight into our plight.



Rhianne Moore is a photographer who tested the best (and worst) camera 
applications, but we are only sharing ones you will love. Below is an excerpt from 
our upcoming e-book, The Android Photographer. 

Excerpt From

The Android Photographer

camera fx

Price: £1.79 / $2.99

Description:  Camera Zoom FX is an award winning photography application that can be 
used instead of the stock android camera application to take photos with powerful camera 
functions. It also has 90 effects, grid overlays and distortions in the post processing mode 
that can be applied to images taken with the app or ones imported from your gallery.

What are its limitations:  In some ways this app is the only app that you would need to use 
– the camera is great and the post processing is efficient, however by trying to cover all the 
bases, the effects can seem limited compared to other apps that only cover this function.

When to use it: This app can be used instead of the stock camera app if you feel it takes 
better photos and provides more options. The stabilising and scene selections also make it 
a better camera for more eventful situations where you may want a steadier photo.

How to: 
1. Open the app through the apps menu and orientate your phone accordingly. The app will 
automatically open to the camera.
2. On the left hand side are the settings for the zoom, the flash, the focus and if your device 
is compatible, the user facing camera.
3. On the right hand side are more manual settings such as the timer, burst mode and more. 
You can also access the apps effects with the top right FX button and the gallery with the 
bottom left image.
4. Once you are happy with your camera settings, you then take a photo by tapping the 
screen or using the shutter button in the centre of the right hand side.



5. Your image will now load on the screen with two sides of menus.
6. The right hand side has the editing options including pre-set options and also a number 
of filters, frames and distortions to choose from. You can also edit the brightness/contrast 
settings or crop your photo from these menus.
7. The left hand menu has the save, share and delete options, so once you are happy you 
can choose one of those and then continue to take photos.

fx camera

Price: FREE

Description: A simple photography app that allows you to take a photo with a number of 
various effects including toycam, polandroid and fisheye options.

What are its limitations: The app is limited to 6 effects to start with and it can only be used 
to take photos rather than edit any existing photos you have already taken.

When to use it: If you want a fast photography  application that applies a certain style of 
effect as soon as you take the photo then this is the app for you, the limited options make the 
process very fast and the saving and taking of further photos is also quick and easy.

How to: 
1. Open the app through the apps menu and orientate your phone accordingly.
2. Choose the style of photo that you want to take from the 6 in the initial menu.
3. Aim your camera and take your photo using the ‘shot’ button.
4. The Autofocus and Configuration button can also be used to edit how the photo will look 
before you take it – this is especially fun with the SymmetriCam option.
5. You can now save, share or delete your image with the buttons along the bottom of the 
phone and then proceed to take more photos.



Darkroom Camera

Price: FREE

Description:  Add special effects to your camera and photos including old, retro, stamped, 
and many more effects.

What are its limitations: This app can be limited by the country that you live in or the android 
device that you use, which is a shame.

When to use it: This app can be used to take photos and to edit them, so if you want to take 
a nice photo or edit existing ones then this app is worth considering.

How to: 
1. Open the app through the apps menu.
2. Choose whether to ‘snap’ a photo or open one through your gallery.
3. Edit the photo with the options along the bottom of the screen.
4. You then have the option to save and/or share your photo.
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Anyone who knows me would agree that I am the polar opposite of a hoarder. Much 
to my husband’s dismay, I’m a big believer in organized cabinets, clean surfaces, and 
overall tidiness. Everything in my home has a place, and don’t even get me started on 
my love affair with labels. There is nothing I love more than taking carloads of unused 
items to Goodwill and freeing up space in an extra closet. It’s a sickness really—I’m 
practically a decluttering addict. However, I’d be lying if I said my entire life was clutter-
free, because despite my tendency to obsess over simplicity, there is one area of my 
daily living that leans towards hoarding. 

You see…I am a hoarder of memories, and thus, a hoarder of photos. 

I fell in love with photography a few years ago when I picked up a camera one day and 
didn’t want to put it down. I still remember the day it happened. My husband and I were 
at Apple Hill, wandering around the orchards and picking out pumpkins. It was one of 
those beautiful, perfect days that you don’t ever want to forget. With a Canon point and 
shoot clenched tightly in my hand, I took over 100 pictures that day. Pumpkins, apple 
strudel, trees, ponds—you name it, I was photographing it. 

As a woman (and a pregnant one at that), I am pretty in touch with my emotions, almost 
to a fault. For me, the greatest benefit of taking pictures is the ability to capture feelings 
in a single photograph. 

Why a Woman Photographs
by Ashlee Gadd



Whether it’s a newborn hand wrapped tightly around his mother’s finger, or a man looking 
adoringly into his fiancé’s eyes, I love being able to record the memories and raw emotions 
of people. Even more so, I love documenting my own memories and keeping them safe 
for the day that I can no longer picture them clearly in my mind. Photos serve as proof; 
evidence of laughter, happiness, love, teeny tiny fingers and toes—that these things 
did, and do exist, long after the moment has passed.

I also think as women, we tend to appreciate beauty in ways most men don’t. I often 
deem weird things as beautiful, like the sun reflecting off the dirty swamp near my house. 
I find beauty in simple things, like old mailboxes and perfectly ripe vegetables. I love 
to find beauty in the subtle instead of the obvious. When you become a photographer 
you start to view the world a little differently, almost as if you’re always looking through 
a lens, always looking for beauty. You notice light, shadows, shapes and colors more 
than before. In addition to personal satisfaction, there is nothing quite like sharing that 
beauty with people who don’t have the time or ability to notice it themselves. 

If you ever find yourself at my house, you can rest assured that you’ll have a clean place 
to sit and a coaster on which to set your glass. I promise you won’t be overwhelmed 
by too many things or unnecessary clutter. Whatever you do, just don’t open my laptop 
or my photo drawer. There you will find sheer chaos—thousands of memories and 
beautiful moments, captured and hoarded in an unorganized fashion. 

by Ashlee Gadd
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